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Необходими знания
· Базови познания за .NET Framework и CLR (Common Language Runtime)

· Базови познания за общата система от типове в .NET (Common Type System – CTS)

· Познания по езика C#

· Познаване на инструментите от .NET Framework SDK

· Базови познания за Windows Installer

Съдържание

· Какво е асембли? Манифест на асембли

· Конфигурационни файлове

· Как CLR намира асемблитата?

· Global Assembly Cache

· Разпространение и инсталиране на програмни пакети

· Инсталационни компоненти

· COM базирани обекти

· Сървърни компоненти (Serviced Components)

· Настройки на Internet Information Server (IIS)

· Промяна на регистрите на Windows

· Споделени инсталационни компоненти (Merge Modules)

· CAB файлове

· Локализиране

· Debug Symbols

· Инсталационни стратегии
· Създаване на MSI инсталационни пакети с VS.NET
В тази тема...
В настоящата тема ще разгледаме най-малката съставна част на .NET приложенията – асемблитата. Ще разгледаме за какво служат, от какво се състоят и как могат да се конфигурират. Ще се спрем на различните техники за разпространение на готовия софтуерен продукт на клиент​ските работни станции и на някои избра​ни техники за създаване на инста​лационни пакети.
Асемблитата в .NET Framework
Асемблитата са основна съставна част на всеки софтуерен продукт, базиран на .NET Framework. Те са най-малката и основна част при раз​пространение на .NET приложения. Асемблитата се състоят от компили​рани .NET типове (интерфейси, класове, структури и др.), метаданни и ресур​си (.bmp, .jpeg, .ico файлове, .resource и .resx ресурси и други). Компи​лираните типове представляват изпълним програмен код във вид на инструкции на междинния език IL. Метаданните описват асемблитата и типовете в тях. Ресурсите могат да бъдат вградени или записани като външни файлове.
Асемблитата могат да бъдат статични и динамични. Статичните асемблита се съхраняват във файл в portable executable (PE) формат, докато дина​мичните се изпълняват директно от паметта и не се записват (във файл) преди изпълнението им. .NET Framework предлага стандартни средства и инструменти за създаване на динамични асемблита и позволява тяхното изпълнение и съхранение с помощта на класовете от простран​ството System.Reflection.Emit.
Асемблитата съдържат IL код за изпълнение

Асемблитата съдържат компилирани .NET типове – програмен код във вид на инструкции на езика Intermediate Language (IL), който се изпълнява от CLR чрез ком​пилация до машиннозависим код. Важно условие за изпъл​нение на IL кода е наличието на метаданни за асемблито и асембли манифест.
Асемблитата се записват във файлове, които са във формат PE (portable executable). Тези файлове най-често носят разширения .exe или .dll. Всеки преносим изпълним файл (PE файл) може да има входна точка за изпълнение – функция DllMain(…), WinMain(…) или Main(…), съответно за динамични библио​теки, Windows GUI приложения и конзолни приложения. Входната точка може да е най-много една.
Асемблитата формират граница за сигурността (security boundary)
Кодът, който се съдържа в дадено асембли, изисква определени права за достъп и изпълнение. Асемблитата са единица, която може да изисква и получава определени права (permissions). Когато се създава асембли, неговият разработчик може да посочи минимален набор от права, които асемблито задължително изисква, за да работи.
Дали определени права ще се дадат на дадено асембли или не зависи от политиките за сигурност на .NET Framework и т. нар. доказа​телства, които има асемблито – цифров подпис, силно име (strong name), местополо​жение (URL, UNC) и др.
Асемблитата формират граница за типовете (type boundary)
Всяко асембли обгръща типовете, които съдържа. Идентичността на типо​вете е свързана с името на асемблито, в което се намират. Това означава, че типът MyType, деклариран в assembly1.dll, не е еднакъв с типа MyType, деклариран в assembly2.dll. Това позволява по-голяма гъвкавост и независимост на имената при капсулиране на функционалност в асемб​литата.
Асемблитата формират граница на видимостта (reference scope boundary)
Манифестът на асемблитата (ще се спрем на него малко по-нататък в настоящата тема) съдържа метаданни, които се използват за намиране на типовете и ресурсите, включени в асемблито. Манифестът определя типо​вете и ресурсите, които са видими извън границите на асемблито (от други асемблита). В него се описват също и асемблитата, които се изиск​ват, за да се изпълни основното асембли.
Асемблитата формират граница на версиите (version boundary)
Асемблито е най-малката единица, която подлежи на версионизиране в CLR. Всички типове и ресурси в дадено асембли се версионизират заедно като един обект.
В .NET Framework е възможно различни версии на едно и също асембли да съществуват и да се изпълняват едновременно без да си пречат. Това решава много проблеми, предизвикани от конфликти във версиите.

Манифестът описва точно версията на асемблито, както и версии​те на асемблитата, които се изискват, за да се изпълни то.
Асемблитата са единица за споделяне

Асемблитата са най-малката единица, която може да бъде споделена меж​ду няколко .NET приложения. Основен начин на споделяне е да се даде на асемблито силно име и се постави в GAC (Global Assembly Cache). Друг начин е да се инсталира като частно асембли към дадено приложение. Подробно ще разгледаме тези техники в частта "Разпространение на асем​блита".
Асемблитата са единици за разпространение (deployment units)
Асемблитата формират основна програмна единица за разпространение. Когато се стартира едно .NET приложение, са му необходими само асем​блитата, които се извикват първоначално. Остана​лите асемблита (като ресурси за локализация или допълнителни модули) се зареждат при пър​вото им поискване (on demand). Това позволява приложе​нията да се поддържат малки и удобни при първоначално разпростра​нение. Тази възможност е особено важна при технологията .NET Zero Deployment, която ще опишем по-късно в настоящата тема.
Метаданни и манифест на асембли

Всяко асембли, независимо дали е статично или динамично, съдържа в себе си метаданни (информация, която го описва).
Метаданните включват описание на съдържаните в асемблито типове и инфор​мация за него самото.
Манифест на асембли

Информацията за асемблито описва как са свързани съдържаните еле​менти помежду си – това е т. нар. манифест. Манифестът съдържа всич​ки метаданни, нужни за описанието на идентич​ността на асемблито, информация за неговата версия, необходимите му права, асемблитата и версиите им, нужни за изпълнението му, както и допълни​телна информа​ция, необхо​дима за извличането на типо​вете и ресурсите. 
Манифестът може да се съдържа в самото асембли (в неговия .exe или .dll преносим изпъл​ним файл) заедно с остана​лите ресурси или като самостоятелен файл, който съдържа само информацията на манифеста.
Следващата илюстрация показва различните начини, по които се съхра​нява манифеста в асемблитата:
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При асемблита, които съдържат един файл, манифестът е вмъкнат в PE файла и образува асембли от един файл. Възможно е създаването на многомодулно асембли с външен манифест или манифестът може да е вмъкнат в един от файловете.
Съдържание на манифеста

Следната таблица показва съдържанието на манифеста:
	Информация
	Описание

	Идентификация
	Име 
	Текст, указващ име на асембли.

	
	Версия
	Съдържа 4 идентификатора разделени с точка във формат: Major.Minor.Build.Revision (напр. 3.44.1234.5543).

	
	Култура
	RFC1766 низ, указващ регионални настройки (locale) на асемблито – например “en-US”. Тази информация трябва да се използва, когато се създава сателитно асембли, съдържащо спе​цифична културна и езикова информация. Възможно е асемблито да е с неутрална кул​тура. (Асемблита с инфор​мация за култу​рата авто​матично се възпри​емат като сателитни).

	
	Информация за силно именуване
	Съдържа публичния ключ, използван за циф​ровия подпис на асемблито, ако то притежава силно име.

	Списък на файловете, включени в асемблито
	Хеш стойност и име на файл, включен в асем​блито. Забележка: Всички файлове трябва да са в папката, където се намира е файлът, съдържащ манифеста.

	Съдържани типове
	Тази информация се използва по време на изпълнение за зареждане на типовете декла​рирани в асемблито.

	Външни асемблита
	Списък с всички външни асемблита, които са статично свързани. Всяко свързано асембли е описано с име и метаданни (версия, култура, и т.н.) и публичен ключ, ако е силно именувано.

	Изисквани права за достъп
	Необходими права, за да се изпълни асем​блито.


Първите четири елемента (име, версия, култура, публичен ключ) обра​зуват идентификацията на асембли – неговото силно име.
Атрибути за работа с манифест
В .NET Framework има няколко атрибута, чрез които можем да влияем на компилацията на асемблитата и да променяме метаданните в техния мани​фест. Тези атрибути се записват в сорс кода на асемблито и при компила​ция модифицират метаданните. Ето по-важните от тях:
	Атрибут на манифеста
	Описание

	AssemblyCultureAttribute
	RFC1766 низ указващ към коя култура принадлежат ресурсите, съдържани от асемблито. Формата е "език"-"страна или регион" – например "en-US" за US English или "bg-BG" за ресурси на бъл​гарски език. Културата може да бъде също неутрална, което показ​ва, че асемблито съдържа ресурси за култу​рата по подразбиране.
Забележка: CLR третира всяко асем​бли с този атрибут за сателитно.

	AssemblyFlagsAttribute
	Указва дали асемблито поддържа ед​новременно различни версии в един компютър, в един процес или в един домейн на прило​жение (т. нар. side-by-side изпълнение, което ще разгле​даме по-подробно в секцията за Global Assembly Cache).

	AssemblyVersionAttribute
	Съдържа 4 идентификатора разде​лени с точка: Major.Minor.Build.Revision (напр. 3.44.1234.5543).

	AssemblyCompanyAttribute
	Текстов низ, указващ име на ком​пани​ята, производител на асемблито.

	AssemblyCopyrightAttribute
	Текстов низ, описващ авторски права.

	AssemblyFileVersionAttribute
	Текстов низ, указващ Win32 файлова версия. По подразбиране това е верси​ята на асемблито.

	AssemblyInformational​VersionAttribute
	Текстов низ, указващ версия, която не се използва от CLR. Това може да бъде версия на продукт или друга, която носи информация за разработчиците.

	AssemblyProductAttribute
	Текстов низ, указващ име на софту​е​рен продукт.

	AssemblyTrademarkAttribute
	Текстов низ, указващ търговска марка.

	AssemblyConfiguration​Attribute
	Текстов низ, указващ конфигурация на асемблито (Release или Debug). CLR не използва този атрибут.

	AssemblyDefaultAliasAttribute
	Текстов низ, указващ псевдоним по подразбиране, който ще се използва при свързване от външни асемблита. Може да бъде лесно за използване име (докато името на асемблито може да не е). Може да е също съкратена форма на пълното име на асемблито.

	AssemblyDescriptionAttribute
	Текстов низ, съдържащ кратко описа​ние на съдържанието и целта на асем​блито.

	AssemblyTitleAttribute
	Текстов низ, указващ лесно име на асемблито (напр. Microsoft Common Dialog Control).


Атрибути за работа с манифест – пример

Ето един пример, в който чрез атрибути се задават метаданни за асем​блито:

	AssemblyInfo.cs

	using System.Reflection;
[assembly: AssemblyTitle("Advanced Toolbar Control")]
[assembly: AssemblyDescription(

"Advanced Toolbar Windows Forms Control")]
[assembly: AssemblyConfiguration("Release")]
[assembly: AssemblyCompany("Software Abuse Corp.")]
[assembly: AssemblyProduct(

"Software Abuse Windows Controls Library")]
[assembly: AssemblyCopyright(

"(c) 2005 by Software Abuse Corp.")]
[assembly: AssemblyCulture("")]
[assembly: AssemblyVersion("3.22.*")]


Във VS.NET метаданните за асемблито обикновено се записват във файла AssemblyInfo.cs, който се създава автоматично с всеки нов проект. В примера сме използвали този файл, за да дефинираме метаданни за асем​блито, до което се компилира текущия проект – контролата "Advanced Toolbar Control".
Създаване на многомодулно асембли

Тъй като VS.NET не може да създава многомодулни асемблита, ако се наложи да използваме такива, можем да ги създадем от командния ред чрез подходящи извиквания на C# компилатора (csc.exe). Да разгледаме стъпките, чрез които можем да създадем асембли, което се състои от няколко файла.
Стъпка 1: Компилиране на модул, който ще бъде използван от други асемблита
Нека имаме файл Utilities.cs със следното съдържание:

	Utilities.cs

	// Assembly building in the .NET Framework – example
using System;

namespace Utilities

{


public class ConsoleFunctions


{ 



public void ConsoleWrite() 



{




System.Console.WriteLine("A line from Utilities!");



}


}

}


Компилираме го с командата:
	csc /target:module Utilities.cs


След успешното компилиране е създаден файл Utilities.netmodule в същата папка.

Стъпка 2: Компилиране на асембли, което използва вече създадения модул

Създаваме файл Client.cs в същата папка:

	Client.cs

	using System;
using Utilities; // The namespace created in Utilities.netmodule
class MainClientApp 

{


// Static method Main is the entry point method.


public static void Main() 


{ 



ConsoleFunctions myFunctions = new ConsoleFunctions();



Console.WriteLine("Client code executes");



// Call function from module Utilities.netmodule



myFunctions.ConsoleWrite();


}

}


Можем да го компилираме с командата:
	csc Client.cs /addmodule:Utilities.netmodule


Този път компилаторът създава файла Client.exe.
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	За да се зареди асемблито трябва да са налични всички модули. Това е се налага от факта, че асемблито се компилира от IL код до машиннозависим код от JIT компи​латора.


Разглеждане на манифеста на асембли с ildasm

Вече се запознахме какво представляват манифестите на асемблитата и как можем да променяме метаданните, които се записват в тях при компи​лация. Нека сега видим как можем да разгледаме манифеста на съществу​ващо асембли.
MSIL Disassembler (ildasm.exe) е придружаващ инструмент към MSIL Assembler (ilasm.exe). С този инструмент може да се разглежда съдър​жанието на асемблитата и модулите. MSIL Disassembler e част от .NET Framework SDK и се намира по подразбиране в директорията
%Program Files%\Microsoft Visual Studio .NET 2003\SDK\v1.1\bin.
За да разгледаме метаданните и манифеста на асемблито Client.exe, получено в горния пример, ще го отворим с MSIL Disassembler чрез следния команден ред:
	ildasm Client.exe
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Двойно щракване с левия бутон на мишката върху “M A N I F E S T” ще отвори прозорец със съдържанието на манифеста:
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Както се вижда, манифестът дефинира асемблито Client, което съдържа модула Client.exe и реферира външния модул Utilities.netmodule от файла Utilities.netmodule, както и външното асем​бли mscorlib и вън​шния клас Utilities.ConsoleFunctions.
Повече информация относно MSIL Disassembler можете да намерите в MSDN – http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cptools/html/cpconMSILDisassemblerIldasmexe.asp.
Силно именуване на асембли

С цел повишаване на сигурността и намаляване на конфликтите с вер​сиите в .NET Framework са въведени т. нар. силно именувани асемблита. Силното име на асембли се образува от неговите име, версия, култура и публичен ключ. Всяко силно именувано асембли е цифрово подписано с частния ключ, съответстващ на публичния ключ, който участва в силното му име. Пример за силно име на асембли е следният низ:
	CompanyNamespace.Controls.Design.v3.2,Version=3.2.111251.37,Culture=neutral, PublicKeyToken=8ty5c3176f5cd04e


Силно именуваните асемблита имат някои предимства пред обикновените асемблита:
· Гарантира се уникалността, с помощта на двойка ключове (public / private key pair). Никой не може да създаде асембли със същото име, без да притежава частния ключ. Асембли, създадено с един частен ключ, се различава от асембли, създадено с друг частен ключ.
· Защитава родословието на версиите. Нова версия, която е създадена без притежаването на същия частен ключ като предходната, лесно може да бъде идентифицирана.
· Защитава се целостта на асемблито и дадените му права (permissions). По този начин се гарантира, че подмяна на асембли, с цел използване на неговите права (permissions) e невъзможно.
Само силно именувани асемблита може да се добавят в областта Global Assembly Cache, която ще дискутираме след малко.
Създаване на силно именувано асембли – пример
В следващия пример ще създадем силно именувано асембли и ще покажем особеностите в неговия манифест.
Първо ще създадем двойка публичен / частен ключ (public/private key pair). За целта използваме Strong Name инструмента (sn.exe), който е част от .NET Framework SDK:
	sn -k keypair.snk


Тази команда генерира по случаен начин двойка публичен/частен ключ и ги записва във файла keypair.snk.

След като вече имаме двойката ключове, можем да пристъпим към създа​ване на силно именувано асембли:
1. Стартираме Visual Studio .NET 2003.
2. Създаваме нов проект от тип Class Library: File -> New -> Project -> Visual C# Projects -> Class Library. Задаваме име на проекта MyStrongNamedAssmbly и потвърждаваме с бутона [OK].

3. Компилираме проекта. Създадохме обикновено асембли (то се намира в поддиректорията bin\Debug\ на проекта, във файла MyStrongNamedAssembly.dll). Неговият манифест изглежда по след​ния начин:
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4. Копираме създадения по-горе файл keypair.snk в папката, която съдържа VS.NET проекта (MyStrongNamedAssembly.csproj).

5. От Solution Explorer отваряме файла AssemblyInfo.cs и намираме реда [assembly: AssemblyKeyFile("")]. Това е атрибутът, който ще използваме, за да посочим двойката публичен/частен ключ. Конструкторът на AssemblyKeyFileAttribute приема като параме​тър име на файл, съдържащ двойката ключове. Може да бъде твърд път (c:\keyfiles\keypair.snk) или относителен път спрямо obj\Debug поддиректорията на проекта. В нашия случай можем да зададем относителен път: ..\..\keypair.snk.
6. Променяме атрибута AssemblyKeyFileAttribute на [assembly: AssemblyKeyFile(@"..\..\keypair.snk")]:
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7. Компилираме проекта отново. Сега вече създадохме силно име​нувано асембли (то се намира отново в поддиректорията bin\Debug\ на проекта, във файла MyStrongNamedAssembly.dll). Неговият ма​ни​фест се различава от предходния по .publickey частта:
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Конфигурационни файлове в .NET Framework
Конфигурационните файлове в .NET Framework са текстови файлове в XML формат и служат за задаване на различни настройки на .NET прило​женията. Съществуват няколко вида конфигурационни файлове:

1. Конфигурационен файл за настройките на машината -  Machine.config – този файл се намира в %runtime install path%\Config (например C:\WINDOWS\Microsoft.NET\Framework\ v1.1.4322\Config) и съдържа настройки оказващи влияние върху CLR за локалния компютър.
2. Конфигурационни файлове на приложенията – съдържат настройки, специфични за дадени приложения. Те са два вида: за уеб-базирани приложения се казват винаги Web.config и се намират в коренната директория на уеб приложението или уеб услугата в Internet Information Server и за Windows-базирани приложения – образуват се от името на приложението с .config разширение (например: ако имаме прило​жение MyLibrary.dll, конфигурационният му файл ще се казва MyLibrary.dll.config).
3. Publisher Policy File – указват на всички приложения да използват по-нова версия на външно асембли от тази, спрямо която са били компилирани (version redirect). По-нататък ще разгледаме как се използват (вж. Създаване на Publisher Policy File).
4. Конфигурационни файлове за сигурността (security policy) – съдър​жат описание на правата за изпълнение на инсталираните асем​блита. В .NET Framework съществу​ват няколко нива на сигур​ност:

· ниво организация

· ниво машина

· ниво потребител

Следващата таблица показва тяхното местоположение в зависимост от операционната система: 

	Enterprise security policy configuration file

	Windows 2000
	%runtime install path%\Config\ Enterprisesec.config

	Windows NT
	%runtime install path%\Config\ Enterprisesec.config

	Windows 98 and Windows Millennium Edition (Windows Me)
	%runtime install path%\Config\ Enterprisesec.config


	Machine security policy configuration file

	Windows 2000
	%runtime install path%\Config\ Security.config

	Windows NT
	%runtime install path%\Config\ Security.config

	Windows 98 and Windows Me
	%runtime install path%\Config\ Security.config


	User security policy configuration file

	Windows 2000
	%USERPROFILE%\Application Data\ Microsoft\CLR security config\ vxx.xx\Security.config

	Windows NT
	%USERPROFILE%\Application Data\ Microsoft\CLR security config\ vxx.xx\Security.config

	Windows 98 and Windows Me
	%WINDIR%\username\CLR security config\vxx.xx\Security.config


Всички тези конфигурационни файлове са важни за разпространението на .NET приложенията, на което ще се спрем след малко.

Как CLR намира асемблитата?
Важно e за разработването и разпространението на .NET приложения да се познава как CLR търси асемблитата, които дадено приложение изисква, за да се изпълни. По подразбиране CLR се опитва да намери асемблитата със същата версия, с която приложението е било компилирано. Когато .NET приложение изиска външно асембли, се изпълняват следните стъпки:
1. Определя се вярната версия на нужното асембли – чрез проверяване на конфигурационните файлове (за настройките на машината, на приложението и publisher policy file).
2. Проверява се дали приложението е използвало асембли със същото име. В такъв случай се зарежда последното използвано асембли.
3. Проверява се Global Assembly Cache. Ако асембли със същото име се намира там, се използва то.
4. Изпълнява се търсене на асембли (assembly probing) чрез следните стъпки:
· Ако конфигурационните файлове не променят версията на изиск​ваното асембли, тогава CLR се опитва да налучка местополо​жението му като се базира на неговото име.
· Ако е намерен <codebase> елемент в конфигурационните файлове се търси само в пътя, посочен там. Ако асемблито не е намерено, се регистрира грешка и се прекратява търсенето.

· Търси се в поддиректориите, посочени в <probing> секцията на конфигурационния файл на приложението. Ако не е намерено асемблито, се прави заявка към Windows Installer да инсталира изискваното асембли. Тази възможност на Windows Installer се нарича инсталиране при заявка (install-on-demand).
	[image: image8.png]



	За асемблита, които не са силно именувани, CLR не прове​рява GAC за тяхното наличие и не проверява версията.


Пример 1: Търсене на асембли (probing)
За да поясним описания процес, ще дадем един пример. Нека имаме Windows-базирано приложение BaseDir\MyApp.exe, което използва ресур​си от асембли MyLibrary, което не е силно именувано. Конфигурацион​ният файл MyApp.exe.config съдържа:

	MyApp.exe.config

	<?xml version="1.0" encoding="utf-8" ?>

<configuration>

   <runtime>

      <assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">

         <probing privatePath="bin;bin2\subdir"/>

      </assemblyBinding>

   </runtime>

</configuration>


При стартиране на MyApp.exe асемблито MyLibrary се търси в следни​те директории:
	BaseDir\MyLibrary.dll

BaseDir\MyLibrary\MyLibrary.dll

BaseDir\bin\MyLibrary.dll

BaseDir\bin\MyLibrary\MyLibrary.dll

BaseDir\bin2\subdir\MyLibrary.dll

BaseDir\bin2\subdir\MyLibrary\MyLibrary.dll

(после същите файлове, но с разширение .exe)


С помощта на инструмента Assembly Binding Log Viewer (Fuslogvw.exe), който е част от .NET Framework SDK, може да се разгледа детайлно в кои директории и в какъв ред търси CLR асемблитата.
Пример 2: Търсене на асембли с тага <codebase>

Нека разширим малко предходния пример. Добавяме в конфигурационния файл MyApp.exe.config таг <codebase> в частта между таговете <dependentAssembly> и <dependentAssembly>.

	MyApp.exe.config

	<?xml version="1.0" encoding="utf-8" ?>

<configuration>

   <runtime>

       <assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">




<dependentAssembly>





<assemblyIdentity name="MyLibrary"/>





<codeBase version="2.0.0.0"





href="CodeBase\MyLibrary.dll" />




</dependentAssembly>




<probing privatePath="bin;bin2\subdir;Lib1"/>

      </assemblyBinding>

   </runtime>

</configuration>


При стартиране на MyApp.exe асемблито MyLibrary се вече търси в само в посочената директория:

	CodeBase\MyLibrary.dll


Забележка: CLR дори не опитва да намери асембли MyLibrary.exe.
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	При посочен таг <codebase> CLR търси асембли само с посочено име и само в посочената директория. Ако не бъде намерено асемблито, търсенето се прекратява и се съобщава за грешка.


Създаване на Publisher Policy File

Файловете с политика на издателя (publisher policy file) са специален вид конфигурационни файлове, които се компилират и инсталират в Global Assembly Cache и указват на всички приложения да използват по-нова версия на външно асембли от тази, спрямо която са били компилирани (version redirect).
Използването на такива файлове можем да демонстрираме чрез няколко стъпки:
1. Създаваме publisher policy file с име pubPolicy.config. Целта на този файл е да укаже на CLR при извикване на асемблито с посочения манифест (име - myRedirectedAssembly, публичен ключ - 32ab4ba45e0a69a1, версия - 1.0.0.0) да се зареди асембли със същото име и публичен ключ, но версия 2.0.0.0.
	pubPolicy.config

	<configuration>


<runtime>



<assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">




<dependentAssembly>





<assemblyIdentity name="myRedirectedAssembly"






publicKeyToken="32ab4ba45e0a69a1" />




<!-- Redirecting to version 2.0.0.0 -->





<bindingRedirect oldVersion="1.0.0.0"






newVersion="2.0.0.0"/>




</dependentAssembly>



</assemblyBinding>


</runtime>

</configuration>


2. Компилираме на publisher policy file до publisher policy assembly. Ще използваме създадения файл, за да създадем асембли и да го именуваме силно (ще използваме същия файл, който създадохме в точката Създаване на силно именувано асембли. Това става с помощта на инструмента Assembly Linker (al.exe):

	al /link:pubPolicy.config /out:policy.1.0.myRedirectedAssembly.dll /keyfile:keypair.snk


Изходът от тази команда е асембли, записано във файл с име  policy.1.0.myRedirectedAssembly.dll.
3. Добавяне в GAC. Необходимо е така създаденото Publisher Policy Assembly да бъде добавено в Global Assembly Cache. Това става със следната команда:

	gacutil /i policy.1.0.myRedirectedAssembly.dll


(За повече информация вж. http://msdn.microsoft.com/library/default.asp?  url=/library/en-us/cpguide/html/cpconcreatingpublisherpolicy​file.asp).
Global Assembly Cache

Всяка машина (персонален компютър, мобилно устройство и др.), на която е инсталиран .NET Framework, има област наречена Global Assembly Cache (GAC). GAC е специално проектиран да съдържа асемблита, които могат да се ползват от няколко различни приложения. Целта е общите компо​ненти от различни софтуерни продукти да не се дублират, а да се публи​куват като общи и да са достъпни за всички приложения. Пример за такъв общ компонент може да бъде библиотека за графичен потребителски интерфейс, която доставя съвкупност от графични контроли. Такива контроли могат да се използват в много приложения и не е необходимо всяко от тях да инсталира библиотеката поотделно.

За да се изяснят по-добре целта и предимствата на GAC, ще опишем първо две други понятия - DLL адът (DLL Hell) и side-by-side execution.
DLL адът (DLL Hell)

DLL ад се нарича ситуацията, в която инсталацията на дадено прило​жение заменя съществуващ файл (.DLL, .OCX или .VBX) с по-стара версия или нова версия, която не е съвместима с по-старите версии. В такъв случай приложения, използващи ресурси от въпросния файл, спират да работят. Последното инсталирано приложение работи, но всички оста​нали, които използват ресурси от въпросния файл, не работят коректно. Потребителят, който не е длъжен да познава тази ситуация, хвърля вината върху производителя на (вече) неработещия софтуер.
Side-by-side execution

Side-by-side execution се нарича възможността едновременно да съще​ствуват и да се използват приложения, компоненти и дори CLR с различни версии на един компютър.

Следващата графика показва компютър, на който има инсталирани версии 1.0 и 1.1 на .NET Framework, четири приложения (A-D), които използват, различни версии на компонента Comp. Версии 1.0 и 2.0 на Comp използват .NET Framework 1.0, докато версия 3.0 използва .NET Framework 1.1. Без съществуването на GAC това не би било възможно.
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Предимства и недостатъци на GAC

Инсталирането на асемблита в GAC има следните предимства:

· Единствено място за инсталиране на асемблита, които се използват от множество приложения. Много по-лесно е за инсталиране на нова версия на даден компонент в GAC и създаване на publisher policy file за пренасочване всички приложения да използват новата версия отколкото да се търсят всички копия в частните папки на различните приложения.

· По-добро бързодействие при цифрово подписаните асемблита – това е така, защото проверката на цифровия подпис се прави веднъж – при инсталиране в GAC, докато при частните асемблита се прави на всяко зареждане.

· По-добро бързодействие и спестяване на ресурси при зареждане на няколко копия от едно и също асембли – в такъв случай CLR просто пренасочва заявките към вече зареденото асембли, вместо да заделя памет и да зарежда асембли в паметта отново.
· Решава проблема с DLL ада и позволява side-by-side execution.
Използването на GAC има и своите недостатъци:

· Асемблитата, които се инсталират в GAC трябва задължително да са силно именувани.

· GAC се намира в %systemroot%\assembly и като поддиректория на Windows се изискват администраторски права, за да се променя съдържанието му.

· Директно копиране в GAC не е допустимо – асемблитата трябва да се инст​алират посредством някой от следните начини:

· Чрез Windows Installer 2.0.
· Чрез от инструмента gacutil.exe от .NET Framework SDK.
· Чрез Windows Shell разширението за Windows Explorer, съдържащо се в SHFusion.dll.

· Чрез административната конзола на .NET Framework – mscorcfg.msc.
· Чрез API функциите на класа Microsoft.CLRAdmin.Fusion от .NET Framework библиотеката mscorcfg.
Работа с GAC – пример
В следващия пример ще използваме силно именуваното асембли MyStrongNamedAssembly.dll от частта "Създаване на силно именувано асем​бли" за да илюстрираме работата с GAC:
1. Добавяме асемблито в GAC със следната команда:
	gacutil /i MyStrongNamedAssembly


2. За да видим съдържанието на GAC използваме командата:
	gacutil /l MyStrongNamedAssembly


Резултатът от тази команда трябва да е подобен на следния:
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3. За дерегистрация (изтриване) на асембли от GAC използваме следната команда:
	gacutil /u MyStrongNamedAssembly


Разпространение и инсталиране на програмни пакети

След като .NET приложението е преминало успешно през фазите на разра​ботване и тестване, трябва да се създаде инсталационен пакет (Windows Installer Package, MSI package), който ще се използва от потребителите на приложе​нието. Много често този етап се подценява от софтуерните раз​работчици, но той е изключително важен от гледна точка на клиента. Инсталацион​ният пакет е първият досег на кли​ента със софтуерния продукт и затова той създава първото впечатление. Към инсталационния пакет има много изисквания но най-важните от тях са следните:
· да поставя на клиентската машина всичко необходимо за нормалната употреба на закупения софтуер, без да се пречи на изпълнението на вече инсталирания софтуер;
· да бъде лесен за използване;
· да предоставя възможност за деинсталиране като възстановява ма​шината до предишното й състояние.

Докато третото изискване е сравнително лесно за постигане със съществу​ващите технологии и второто зависи от комплектността и аудиторията, към която е насочено приложението, то за първото е необходима предва​рителна подготовка. Това се обуславя от факта, че различните типове приложения се инсталират по различен начин.
В зависимост от типа на приложението инсталационният пакет включва различни комбинации от съставните части на приложението: файлове и папки, асемблита, инсталационни компоненти, COM обекти, сървърни ком​поненти, бази данни, настройки на Internet Information Server и т. н.
Файлове и папки

Съществуват много различни видове файлове, които могат да бъдат инсталирани заедно с приложението. Типовете файлове зависят от голе​мината, целта, вида и сложността на приложението. Следващата таблица показва най-често използваните типове файлове, които се разпространя​ват с .NET базираните приложения:
	Тип на файла
	Windows приложе​ние/услуга
	Уеб приложе​ние/услуга

	изпълними файлове (.exe)
	X
	X

	динамични библиотеки (.dll)
	X
	X

	конфигурационни файлове (.config)
	X
	X

	бази от данни
	X
	X

	уеб страници (.htm, .html и др.)
	
	X

	уеб форми (.aspx, .ascx и др.)
	
	X

	файлове за уеб услуги (.asmx, .disco, ...)
	
	X

	XML, XSD файлове
	X
	X

	други необходими файлове
	X
	X


Конфигурационни файлове
Както вече описахме, конфигурационните файлове съдържат определени настройки, влияещи върху изпълнението на програмата. Най-големият проблем при разпространение на конфигурационните файлове е тяхното управление при инсталиране в различни обкръжаващи среди.
Например, ако в даден проект се разработват Windows приложение и уеб услуга, то в конфигурационния файл на Windows приложението ще се съхранява URL до тази уеб услуга. URL адресът обаче ще е различен при различните етапи на разработване, тестване, интегриране на системата и при реално функционираща среда. Необходимостта от различни конфигу​рационни файлове се отежнява и от факта, че за отдалеченото извикване (.NET Remoting) са необходими допълнителни настройки в конфигура​ционните файлове, които коренно се различават в различните среди и трябва да се тестват цялостно при използване на .NET Remoting техноло​гията.

Използване на конфигурационни файлове

За да се управляват по-лесно различите конфигурации, може да се използва следното решение:
1. Добавяме конфигурационен файл, необходим за средата за разра​ботка към проекта във Visual Studio .NET (App.config или Web. config в зависимост от типа на проекта). Visual Studio .NET автоматично добавя Web.config при създаване на ново ASP.NET приложение.
2. Създаваме отделен конфигурационен файл за всяка среда, където настройките се различават. Именуваме ги така, че от името им да става ясно за каква среда са необходими (напр. Test.Web.config, Production.Web.config ) и ги добавяме към проекта.

3. Включваме само необходимия конфигурационен файл в зависимост от средата, в която ще се инсталира, и го преименуваме на изисква​ното име като част от инсталационния процес. Изискваните имена са <AppName>.exe.config за Windows приложения или Web.config за уеб приложения.
Процесът на инсталиране на конфигурационен файл в тестова среда е подобен на този за реално функционираща среда. Ако, обаче, се инсталират различни конфигурационни файлове, тогава файлът за реално функциониращата среда няма да премине необходими тестове (ще остане нетестван).
Един от начините за решаване на този проблем е да не се създават различни файлове за тестовата и реалната среда. Ако са необходими допълнителни настройки в конфигурационния файл за тестване, тогава тестващият екип може да ги променя преди да започне тестовете.
Файлове за  уеб услуги

Много от проблемите, засягащи инсталирането на уеб приложенията се отнасят и за уеб услугите – настройки на IIS, инсталиране на HTTP модули и обработчици (HTTP handlers).
Малка разлика между уеб приложенията и уеб услугите представлява видът на файловете. За уеб приложенията се инсталират предимно .aspx и .ascx файлове, докато уеб услугите изискват .asmx и .disco файлове.
XSD файлове

XSD файловете са документи, които служат за дефиниране и проверка на съдържанието и структурата на XML документи. Инсталиране на XSD файлове е необходимо само ако приложението има нужда от тях по време на изпълнението си. Например, ако метод разработен в уеб услуга връща като резултат силно типизиран DataSet, тогава XSD файлът трябва да се инсталира (заедно с ASMX и DISCO файловете), тъй като уеб услугата ще съдържа референция към него. Когато разработчиците разглеждат DISCO файла на тази услуга от Visual Studio .NET те ще могат да разгледат и схемата чрез връзката View Schema.

J# инсталационен пакет (J# Redistributable Package)
Инсталация на Visual J# .NET Redistributable Package (vjredist.exe) е необходима, ако приложението използва компоненти или библиотеки написани на Visual J#, понеже J# не е част от .NET Framework, а е допълнително разширение.
Асемблита

Инсталирането на многомодулни асемблита изисква наличието на всички модули. В противен случай използването на асембли с липсващ модул ще предизвика грешка.
Силно именувани асемблита

Когато .NET приложение създава референция към силно именувано асембли, CLR изисква да бъде включена неговата версия. При стартиране на приложението CLR ще търси асембли с посочената версия. Това означава, че ако асембли с по-нова версия бъде копирано върху файла със старата версия, приложението ще спре да работи. 

Едно от възможните решения е инсталиране на силно именуваното асем​бли в GAC. По-късно, при разработване на асембли с по-висока версия се разработва и Publisher Policy File, който описахме в точката за Конфигурационни файлове. Новото асембли и Publisher Policy File също се инсталират в GAC. По този начин всички приложения започват да изпол​зват новата версия на асемблито.

Частни асемблита

Ако дадено асембли е проектирано да се използва само от едно прило​жение, то трябва да се инсталира като частно асембли. Частните асем​блита обикновено се инсталират в папката на приложението. Други  подходящи местоположения на частните асемблита са:

· Директорията, съдържаща изпълнимия файл или нейна поддирек​тория.
· Bin папката, намиращата се във виртуалната директория на уеб приложението или уеб услугата в IIS.

· Местоположение описано с <codebase> елемент в конфигурационния файл на приложението.
В повечето случаи частните асемблита следва да се инсталират в директо​рията, съдържаща изпълнимия файл, понеже това е мястото откъдето CLR започва търсенето.

Частните асемблита се използват само от приложението, с което са инста​лирани. По този начин приложението е изолирано от останалия софтуер на машината. Това е един от начините да се избегнат проблемите с различните версии – т. нар. "DLL ад".

Споделени асемблита

В някои случаи едно и също асембли може да се използва от няколко приложения. Тогава съществуват следните възможности за инсталация:
· Инсталиране на асемблито с всяко приложение като частно асембли – по този начин всяко копие е абсолютно независимо от останалите. Инсталирането на множество копия поражда определени проблеми, които следва да се вземат под внимание: възможно е да съществуват множество версии на асемблито, които дори използват различни версии на .NET Framework; при наличието на определени проблеми с асемблито, които са отстранени в следващи версии се създават трудности със замяната на всички копия на машината.
· Инсталиране на асемблито в една обща директория – за всяко от използващите го приложения се посочва тази директория с <codebase> елемента в конфигурационния файл. Ако се използва една директория за всички споделени асемблита на дадена компа​ния, се загубва възможността за side-by-side execution, но се решават проблемите с версионизиране на асемблитата (за да е възможен ъпгрейд на асемблита с просто копиране те не трябва да бъдат силно именувани). Трябва да се планира внимателно избор на подобна стратегия, защото, ако на следващ етап възникне изискване за използване на side-by-side execution, стратегията трябва да се смени, което ще доведе до трудности.
· Инсталиране в GAC – препоръчително е при инсталиране на асембли в GAC да се изпълнява броене на референциите, за да се избегне премахването на асембли от GAC, докато все още съществува приложение на машината, което го използва. Съществуват два начина да се постигне това: чрез Windows Installer или чрез gacutil.exe (използват се параметри /ir за инсталиране и /ur за деинсталиране чрез броене на референциите). 
Потребителски контроли тип Windows Forms (Windows Forms User Controls)

Потребителските контроли тип Windows Forms са асемблита, които могат да се извикват от уеб страници като се свалят на клиентската машина и се стартират локално на нея. По подразбиране такива контроли работят с нама​лени права, за да не застрашават сигурността на потребителя.

Инстали​рането на този тип контроли поставя известни предизвикателства, понеже те се изпълняват в контекста на правата, дадени им от уеб брау​зъра и от политиките за сигурност на .NET Framework.

От гледна точка на сигурността съществуват два вида потребителски контроли тип Windows Forms – такива, които се стартират с права по-подразбиране, и такива, които изискват по-високи права.
Контролите, които изискват по-високи права за изпълнение следва да бъдат силно именувани (strong-named) или цифрово подписани (digitally signed). Това позволява на администраторите да разрешат по-високи права на асемблита от дадена компания, без да компрометират сигур​ността.
Изискването за промяна настройките на сигурността прави контроли от този тип да бъдат по-лесни за използване в корпоративна Интранет среда, където администраторите на домейни централизирано могат да променят тези настройки. За да бъдат контролите използваеми през Интернет, потребителите трябва да следват определени инструкции, за да променят настройките на сигурността.
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	Добра практика е създаване на инсталационен пакет с Windows Installer, който прави необходимите промени в сигурността. Това спестява на потребителите следване на сложни инструкции, които са непонятни за тях. (Въпреки това промените, които се правят от инсталационния пакет би следвало да бъдат добре обяснени.)


Инсталационни компоненти

Разпределените .NET приложения се състоят не само от традиционни програмни файлове и асемблита, но и от допълнителни ресурси като опашки от съобщения (message queues), логове на събитията (event logs), индикатори за производителността (performance counters) и бази данни (databases). Тези ресурси са необходими за нормалното функциониране на приложенията и като такива следва да бъдат създадени по време на инсталационния процес.
.NET Framework предоставя компоненти, които създават и конфигурират ресурсите по време на инсталация и ги изтриват по време на деинста​лация. Тези компоненти се интегрират с инстала​ционните инструменти (InstallUtil.exe) на Windows Installer и Windows Installer Service. Съще​ствуват два типа инсталационни компоненти: предварително създадени инсталационни компоненти и инсталационни класове (Installer Classes).
Предварително създадени инсталационни компоненти

Майкрософт предоставят пет предварително дефинирани инсталационни компоненти, които могат да бъдат използвани при създаване на инстала​ции за приложения:
· EventLogInstaller – използват се при създаване и настройване на логове на събитията (event logs).
· MessageQueueInstaller – използват се при създаване и настройване  на опашки от съобщения (message queues).
· PerformanceCounterInstaller – използват се при създаване и нас​тройване на индикаторите за производителността.
· ServiceInstaller и ServiceProccessInstaller – използват се при създаване и настройване на Windows услуги.
Всеки един от тези класове се използва, за да се инсталират необходи​мите ресурси по време на инсталационния процес. След добавяне на определен компонент в дизайн изгледа на Visual Studio .NET има възможност за генериране на съответния инсталационен клас чрез контекстното меню на компонента, както е показано на картинката:

[image: image13.png]MyEventlog

View Code

au

Cony.

paste

EWC NS

Properties





При добавяне на инсталационния компонент към проекта се създава клас, наречен ProjectInstaller, който съдържа инсталационните класове на всички компоненти използвани.
По време на инсталационния процес се задейства ProjectInstaller, който изпълнява инсталация за всеки от съдържащите компоненти.

Инсталационни класове (Installer Classes)

В някои случаи се налага да се инсталират ресурси, за които няма пред​варително създадени инсталационни компоненти. Може да се наложи да се изпълнят някои специфични действия по време на инсталационния процес. Добър пример за това е създаване на база данни, попълване на някои таблици и прекомпилиране на дадено асембли до native код (чрез инструмента NGen.exe) след успешно приключване на инсталацията. За тази цел могат да се използват класовете от пространството System. Configuration.Install и най-вече класа Installer, който се наследява за да се имплементира потребителски инсталатор за даден компонент.
COM базирани обекти

Възможно е в бъдеще компонентите, изградени с помощта на .NET Framework да заменят изцяло компонентите базирани на Component Object Model (COM, COM+, DCOM – за повече информация виж http://www.microsoft.com/com). Докато настъпи този момент, обаче, ще трябва да имаме предвид тяхното съществуване и да им отделим подхо​дящото внимание.
За да бъдат използваеми всички COM базирани компоненти, трябва да бъдат регистрирани на компютъра и да са инсталирани в COM+ каталога.

Главното предизвикателство в разпространението на COM базирани ком​поненти е в това да бъдем сигурни, че те могат да комуникират с асембли​тата на приложението, както и асемблитата да могат да бъдат извиквани през COM.

При инсталиране на COM базиран компонент трябва да бъде извършена регистрация в COM+ каталога (чрез regsvr32.exe или Windows Installer) и .NET приложението, което го използва трябва да има достъп до Interop асемблито, съдържащо дефиниции на типовете в COM обекта (генерира се чрез tlbimp.exe).

При инсталиране на асемблита, които ще се извикват през COM трябва да се извърши регистрация чрез .NET Framework SDK инструмента Assembly Registration Tool (regasm.exe).
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	При инсталирането на асемблита, които ще се извикват през COM имайте предвид, че ако асемблито няма да се инсталира в GAC, трябва да се използва параметъра /codebase при регистрация с Regasm.exe (или съответното настройване при Windows Installer, както ще видим в примера по-долу). В противен случай COM няма да може да открие местоположението на асемблито.


Сървърни компоненти (Serviced Components)
Сървърните компоненти, създадени с .NET Framework, разчитат на COM за предоставянето на компонентни услуги като управление на транзакциите (transaction management), пулинг на обекти (object pooling) и като цяло предоставяне на услуги, които се обуславят от COM технологията.
Сървърните компоненти се стартират като COM базирано приложение и затова те трябва да регистрират в COM каталога. Това налага следните инстала​ционни и конфигурационни изисквания за компонентните услуги:

· Асемблитата трябва да са силно именувани.
· Асемблитата трябва да са регистрирани в регистрите на Windows (Windows registry).
· Библиотеката с типовете (type library) трябва да е регистрирана при клиента.
Динамична регистрация на сървърни компоненти

Сървърните компоненти често се регистрират динамично първия път, когато приложение се опита да ги използва. Тогава CLR регистрира асемблито, библиотеката с типовете и конфигурира COM+ каталога. Регистрация се прави само веднъж за дадена версия на асембли. Това е най-лесният начин за регистриране на сървърни компоненти, но за да е успешен процесът, който ги стартира, трябва да има административни права върху машината. Допълнително ограничение е фактът, че динамич​на регистрация е възможна само ако асемблито се извиква от управляван код. Ако извикването се прави от неуправляван код, динамич​ната реги​страция не е възможна.
В много случаи процесът, който извиква асемблито, няма изискваните права, за да извърши динамична регистрация. Пример за това са компо​ненти, които се извикват от уеб приложение. Такива компоненти не могат да бъдат регистрирани, защото ASP.NET процесът няма администра​тивни права (освен ако не е настроен да се изпълнява в контекста на потре​бителя SYSTEM, което не е добра идея и компрометира сигурността). В такъв случай регистрацията ще се провали ще се предизвика грешка „отказан достъп” (access denied). Затова трябва да направим необходи​мата регистрация по време на инсталационния процес. 

Регистрация на сървърни компоненти при инсталация

Понеже сървърните компоненти използват предимствата на COM+ услуги​те, те имат същите изисквания относно инсталацията:
· Комуникацията със сървърните компоненти се осъществява през DCOM по подразбиране. Поради тази причина Interop асемблитата трябва да се регистрират на клиентската машина.

· В допълнение към COM+ настройките, които се правят декларативно при разработката на асемблито с помощта на атрибути (виж [TODO: връзка към глава атрибути]), трябва да осигурят, че конфигура​ционните настройки (като присъединяване на потребители към потребителски групи, настройване на подходящи права за изпълне​ние, задаване в кой контекст на сигурност (security context) ще се изпълнява процесът) са подходящо създадени и компонентът е готов за използване. Това може да бъде постигнато чрез добавяне на скрипт към допълнителните действия (custom actions) на Windows Installer, който да регистрира компонента.
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	Възможно е настройването на COM+ приложението да използва SOAP вместо DCOM. Това заобикаля изискването да се инсталират Interop асемблита на клиентската маши​на. Този метод не позволява да се използва създадената от DCOM транзакция клиент-сървър и трябва да се добави допълнителен код, който да управлява транзакциите.


Настройки на Internet Information Server (IIS)

ASP.NET приложенията изискват наличието на Internet Information Server (IIS), за изпълнението си. В някои случаи е необходимо да се правят промени по настройките на IIS, за да се изпълни приложението. При инсталиране на ASP.NET приложения на Windows Server 2003, те се изпълняват от IIS 6.0. При по-стари версии на Windows, се използва IIS 5.0 или 5.1.
IIS 6.0 позволява два режима на изолация на приложенията:

· изолация на работния процес (по подразбиране)

· IIS 5.0 режим на изолация
IIS 6.0 и изолация на работния процес

Когато ASP.NET приложенията работят в режим на изолация на работния процес, те работят в процеса W3wp.exe. В този случай моделът на проце​сите, който е вграден в ASP.NET е изключен и се използва архитек​турата на изолация на работния процес от IIS 6.0. С този режим на изолация може да се изолира всичко (от дадено уеб приложение до множество сайтове) в собствен процес на WWW услугата (WWW Publishing Service), като по този начин дадено проблемно приложение не може да повлияе негативно на останалите.
Процесите, изпълняващи отделните приложения, са напълно разделени от основната WWW услуга – Inetinfo.exe. ISAPI приложенията (Internet Server Applications) също работят напълно отделно от WWW услугата, което предпазва всички сайтове на сървъра от грешки в изпълнението им. Ако възникне грешка в ISAPI приложение, само процесът, който съдържа проб​лемното ISAPI, е засегнат.
Работният процес може да бъде конфигуриран да използва определен процесор, което позволява по-голям контрол върху разпределението на системните ресурси. Като допълнение уеб приложе​нията се стартират в контекста на Network Server акаунта, който има по-малки привилегии за достъп от LocalSystem. Това води до повиша​ване на сигурността.
IIS 5.0 и режим на изолация

Ако се използва изолационният модел на IIS 5.0, ASP.NET се изпълнява в собствения модел на процесите (Aspnet_wp.exe) и използва собствените конфигурационни настройки. Зададеният изолационен модел е на ниво сървър и важи за всички приложения, използващи IIS.
IIS 5.0 режим на изолация трябва да се използва от приложения, които влизат в конфликт с режима на изолация на работния процес. Следните характеристики създават посочения конфликт:

· Зависимост от Inetinfo.exe. Ако приложението изисква да се стартира в контекста на процеса Inetinfo.exe, тогава трябва се използва IIS 5.0 режим на изолация.
· Изисква се използването на Read Raw Data Filters. Тяхното изпол​зване изисква IIS 5.0 режим на изолация.

· Изисква Dllhost.exe. Приложенията, които трябва да се изпълняват в обкръжението на Dllhost.exe могат да бъдат изпълнени само в IIS 5.0 режим на изолация.
Ако е необходимо изпълнението на приложение което, не изпълнява изискванията за изпълнение в режим на изолация на работния процес, трябва да се премине към IIS 5.0 режим на изолация. В такъв случай не могат да се използват предимствата на изолацията на работния процес от IIS 6.0.
Конфигуриране на изолационния режим

Изолационният режим може да се конфигурира от административната конзола на IIS по следния начин (примерът е с Windows 2003 Server):
1. Стартираме административната конзола на IIS от Control Panel -> Administrative Tools -> Internet Information Services (IIS) Manager:
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2. Избираме с десен бутон на мишката Web Sites и от контекстното меню – Properties.
3. Появява се диалоговия прозорец “Web Sites Properties”. Избираме таба Services:
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4. В зависимост дали е избрана опцията (Run WWW service in IIS 5.0 isolation mode) се определя изолационния режим, в който се изпълнява Internet Information Server.

5. След промяна на изолационния режим е необходимо рестартиране на IIS, за да влязат в сила направените промени.

Конфигурация на ASP.NET приложенията

Конфигурацията за ASP.NET приложенията се съхраняват в <processModel> елемента от файла machine.config. Ако се използва IIS 6.0 в режим на изолация на работния процес, се използват само следните настройки:

· maxWorkerThreads – максимален брой нишки на процесор, които изпълняват ASP.NET приложенията
· maxIoThreads – максимален брой нишки на процесор, които изпълняват входно-изходни зачачи
· responseDeadlockInterval – задава максимално време, за което всяка заявка трябва да приключи (процесът се рестартира, ако някоя заявка се забави повече)
Всички останали настройки се игнорират. В някои случаи другите настройки са без значение за IIS 6.0, но в други следва техните екви​валенти в IIS 6.0 метабазата да бъдат указани. За повече информация виж “Mapping ASP.NET Process Model Settings to IIS 6.0 Application Pool Settings” в MSDN Library.
Промяна на регистрите на Windows

.NET приложенията би следвало да използват в по-малка степен регис​трите на Windows отколкото Win32 приложенията. Например асемблитата не изискват съществуването на ключове в регистрите за разлика от COM базираните обекти в миналото. В някои случаи приложенията все още разчитат на регистрите, например когато:
· Приложенията включват компоненти, които не са изградени с .NET Framework като COM, COM+ или услуги под Windows (Windows services).
· Асемблитата трябва да комуникират с COM базирани компоненти или предос​тавят услуги, достъпни през COM. В такъв случай записите в регист​рите трябва да се направят по време на инсталационния процес.

· Необходимо е добавянето на записи относно лицензиранe или версионизиране.
Споделени инсталационни компоненти (Merge Modules)

Споделените инсталационни компоненти са преизползваеми модули за Windows Installer (обикновено са файлове с разширение .msm). Те не могат да се инсталират директно, а трябва да се включат в инсталацион​ния пакет на приложението, което ги използва. Както динамично свърза​ните библиотеки позволяват преизползването на код и ресурси от няколко приложения, така споделените инсталационни компоненти позволяват споделяне на инсталационен код между MSI пакетите. По този начин се осигуряват едни и същи действия за коректно инсталиране на определен компонент с всички приложения, които го използват. Споделените инста​лационни компоненти са подходящи за инсталирани на компоненти на други производители, използвани в нашето приложение (например MSDE – Microsoft SQL Server 2000 Desktop Engine).
Споделените инсталационни компоненти могат да бъдат използвани само в инсталационни пакети на Windows Installer и по никакъв друг начин.

CAB файлове

CAB файлове се използват, за да се пакетират заедно файлове, които са необходими за дадено приложение, така че да могат да се разпространя​ват по-лесно.
Създаването на CAB файлове предоставя следните предимства:

· Позволяват сваляне от Интернет и контролите с управляван код, които се съдържат в тях, могат да се изпълняват при поискване (on demand).
· Позволяват няколко нива на компресия, което намалява времето за изтеглянето им по мрежата.

· Позволяват използването на Microsoft Authenticode® технологията за подписване на CAB файловете, така че може да се покаже на потребителите кой е производителят.

· Съдържат контроли, които лесно могат да бъдат подменени с по-нова версия, чрез създаване на нов CAB файл и поставянето му на уеб сървър. CAB файловете поддържат версионизиране, като по този начин се осигурява използването на най-новата версия от потреби​телите.

Локализиране

CLR предоставя поддръжка за извличане на културно-зависими ресурси, които са пакетирани и инсталирани в сателитни асемблита. Сателитните асемблита съдържат само ресурси, които се използват от приложението (.resx, .gif, .jpeg и др.). Те не съдържат изпълним код.
Когато се използва моделът със сателитните асемблита за локализиране на приложенията, структурата е следната: съществува главно асембли съдържащо културата, която се използва по подразбиране и множество сателитни асемблита. В главното асембли се пакетират културно-незави​симите ресурси и се създава сателитно асембли за всяка култура, която ще се поддържа. Понеже сателитните асемблита не са част от главното асембли тяхната замяна или ъпгрейд са много лесни и се осъществяват без да се променя главното асембли на приложението.
	[image: image18.png]



	Ако главното асембли на приложението е силно имену​вано, сателитните асемблита трябва да са силно имену​вани и подписани със същия частен ключ. В противен случай ресурсите в сателитните асемблита няма да бъдат заредени.


При създаване на .NET приложения, поддържащи множество култури, процесът по разпространение може да се изпълни по няколко начина:
Подход 1: Language packs
Най-лесният подход при разпространение на локализирани приложения е създаване на основен инсталационен пакет и набор от инсталационни пакети за поддържаните култури (познати като езикови пакети - language packs). По този начин клиентите инсталират основния пакет и след това необходимите езикови пакети.

Подход 2: Използване на споделен инсталационен компонент
· Пакетиране на основните, културно-независими асемблита в споде​лен инсталационен компонент (Merge module) чрез Visual Studio .NET setup and deployment project.
· Създаване на инсталационен проект, който съдържа локализираните ресурси за всички поддържани култури.
· Създаване на MSI пакет за всяка култура. Това позволява локализи​ране и на инсталационния процес, а не само на приложението.

· Създаване на базов инсталационен пакет за основната култура, която ще се поддържа и след това се създава трансформация (transform) за всяка допълнителна култура, която ще се поддържа.
· Добавяне на компилираните асемблита от проекта (project output), който съдържа локализираните ресурси във всеки проект на Windows Installer. Важно е включването на всички локализирани ресурси. След това се използва филтър (ExcludeFilter) за изключване всички (освен една) култури от инсталацията.
Подход 3: Инсталиране на всички ресурси
Като друга алтернатива на филтрирането на излишните ресурси по време на създаване на инсталационния пакет е разпространение на всички локализирани ресурси. Единствения недостатък е, че инсталационният пакет може да стане прекалено голям поради излишните сателитни асемблита. Голямото предимство на този подход е, че може да се използват различните култури на една и съща машина. Всичко, което трябва да направи потребителя, е да смени регионалните си настройки и при следващо стартиране на приложението ще се заредят подходящите сателитни асемблита.
Debug Symbols

Когато се създава приложение с помощта на Visual Studio .NET 2003 се създават два вида конфигурации по подразбиране – Release и Debug. Едно от основните различия между тях е начинът, по който се управляват дебъг символите. С Debug конфигурацията се създава файл с дебъг символите за програмата (.pdb – program database), докато при Release такъв файл не се създава по подразбиране.
Файлът с дебъг символите е необходим на CLR, за да свърже компили​рания MSIL код със сорс кода. Това позволява на дебъг-инструментите да показват информация като имена на променливи; на JIT компилатора да създаде проследяваща информация, чрез която да се свърже машинно-зависимия код (native code) обратно до MSIL. Проследяващата информа​ция и символните файлове са необходими за ефективно дебъгване на управлявания код.
Включването на символните файлове в инсталационните пакети помага да се локализират грешките (JIT компилаторът показва дори номера на реда в кода, където е възникнала грешката), затова е препоръчително да се включат в инсталационните пакети по време на тестовете, а при приключ​ване на тестването да се премахнат.
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	Въпреки, че е удобно намирането на грешки с помощта на символните файлове, те не трябва да се разпространяват заедно с приложението, защото позволяват много лесно да се направи reverse engineering и да се извлече изход​ния код в почти оригинален вид. 


Конфигуриране генерирането на дебъг информация:

Генерирането на символните файлове се определя с /debug ключа на компилатора от командния ред (csc.exe) или във Visual Studio .NET от прозореца с характеристиките на проекта (от страницата Build от групата Configuration Properties):
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Инсталационни стратегии
Съществуват различни инсталационни стратегии и изборът на една от тях е тясно свързан със спецификата на приложението, на организацията като цяло и бъдещите планове относно приложението. Трябва внимателно да се планира целият процес по разпространение на приложението преди да се предприемат стъпки по изграждане на инсталационните пакети, защото изборът на инсталационна стратегия може изцяло да промени начина, по който се изграждат инсталационните пакети. 
Един от основните фактори, които определят стратегията, е типът на приложението – Windows Forms базирано или Web Forms базирано.

Съществуват три основни начина за разпространение на .NET приложе​ния:

· No-touch deployment

· Инсталационни пакети на Windows Installer

· Копиране на файлове

Нека разгледаме подробно всеки един от тях.

No-Touch Deployment (.NET Zero Deployment)
При този подход Windows базирани приложения се поставят на уеб сървър и клиентите ги инсталират като се свързват със сървъра посредством HTTP протокола. При първоначално свързване на клиент се изтеглят асембли​тата, които са необходими първоначално. След това при първо използване се свалят и реферираните асемблита (on demand). По този начин клиентът не чака да се свалят асемблита, които няма да ползва веднага и така се разпределя мрежовото натоварване. Асемблитата се свалят в Assembly Download Cache (<windir>\assembly\download\) и се съхраняват там.
Изключителното предимство на тази технология е, че се комбинира богатият потребителски интерфейс на Windows базираните приложения с лесната инсталация и поддръжка, характерна за уеб приложенията. Понеже асембли​тата се свалят само когато са необходими, се минимизира времето за начално зареждане на приложението. Всичко това се случва автоматично – когато клас от главното асембли създава инстанция на клас от асембли, което се намира в същата папка на уеб сървъра, CLR го сваля.

При всяко стартиране на приложението (и първоначално използване на асембли) CLR проверява дали асемблитата на уеб сървъра имат по-нови версии от тези в кеша и при необходимост сваля по-новите версии. По този начин инсталирането на по-нови версии е изключително лесно, като всичко, което е необходимо да се направи, е да се заменят асемблитата на уеб сървъра с по-нови версии.
Кога да ползваме No-Touch Deployment?
В някои случаи използването на no-touch deployment не е подходящо:

· При необходимост да се контролира строго мрежовият трафик и да се прогнозира неговото използване. Тъй като асемблитата се свалят само когато са необходими, съществува потенциална възможност за пикови натоварвания на мрежовите ресурси, когато много потреби​тели изискват едновременно някои асемблита.
· При необходимост за използване на приложението offline. Съхраня​ване на асемблитата в кеша позволява тяхното стартиране дори когато няма връзка с уеб сървъра, но в такъв случай ще се изпол​зват само вече кешираните асемблита. При използване на функцио​налност от асемблита, които не са свалени, ще възникне грешка, тъй като CLR не може да ги изтегли.
· Когато се изискват допълнителни действия по време на инстала​ционния процес като инсталиране на COM обект или драйвер за устройство.

· Когато са необходими високи права. По подразбиране приложе​нията, разпространявани с no-touch deployment, се стартират в ограничен контекст на сигурността. Не е подходящо използването на тази технология, когато не е практично да се променя политиката по сигурността (security policy).
· Когато е необходимо поставянето на асембли в Global Assembly Cache.
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	Дали приложението работи в online или offline режим се определя от режима на Internet Explorer. Дори и компю​търът да има връзка с даден уеб сървър, ако Internet Explorer е в offline режим, тогава и CLR ще работи в offline режим.


Ако смятате да разпространявате приложението чрез .NET Zero Deployment, е добре планирането да започне още от етапа на дизайна му. Това ще позволи решаването на някои проблеми при дизайна (като например ограничените права на приложението) вместо срещането им след като приложението е вече в употреба.
Възможно е използването на устройство в локалната мрежа (network share), вместо уеб сървър. По този начин потребителите се свързват и директно стартират приложението оттам. Чрез този подход асемблитата не се кешират, а се зареждат директно в паметта. Основен недостатък е, че е невъзможно offline използването при срив на мрежовото устройство.

Споделени асемблита
.NET Zero Deployment не поддържа инсталиране на споделени асемблита в Global Assembly Cache. Това означава, че ако е необходимо да се поставят определени асемблита там, трябва да се използва друг инсталационен механизъм. Преди да се възприеме тази техника трябва внимателно да се реши трябва ли да се инсталират асемблита в Global Assembly Cache въобще. Трябва да се има предвид алтернативата да се разпространяват асемблитата като частни (виж Частни асемблита) с всяко приложение. Частните асемблита създават проблеми с ъпгрейда на асемблитата, но това се компенсира от лекотата, с която се разпространяват нови версии при .NET Zero Deployment (просто копиране на уеб сървъра и при следва​щото стартиране всеки клиент ще използва новата версия).
Приложения, състоящи се от множество асемблита

Приложения, които се състоят от едно асембли са най-лесни за разпрост​ранение чрез .NET Zero Deployment. Често, обаче, напълно функционал​ните приложения използват множество асемблита и множество ресурси. Разпространението на такива приложения с .NET Zero Deployment е възможно, но изисква допълнителни усилия от разработчиците, за да се осигури оптимизация.
С цел извикване на асемблита само когато са необходими може да се използва класът Assembly от пространството System.Reflection. Assembly. В този клас има метод LoadFrom(string path, …), чийто параметър path приема както URL, така и пълно име на локален файл. Когато е подаден URL като параметър, CLR проверява дали изисква​ното асембли не съществува вече в download кеша. Предимството на тази техника е, че асемблито се сваля от уеб сървъра, само когато е извикано от приложението (on demand), въпреки, че може да доведе до забавяне на приложението докато асемблито се свали на локалната машина.
Решение на проблема с ограниченията на .NET Zero Deployment техно​логията е използване на комбиниран метод на инсталация – компонен​тите, за които трябва да се предоставят често нови версии, се поставят на уеб сървър, а политиката на сигурността и останалите компоненти се инсталират чрез Windows Installer технологията.
Този подход набра популярност и Майкрософт решиха да го доразвият във .NET Framework 2.0 и нарекоха технологията ClickOnce. На етап от Visual Studio .NET 2005  и .NET Framework 2.0 основните възможности, които са добавени, са следните:
· Уведомяване на клиентите при публикуване на нова версия. 

· Избор на потребителите дали да инсталират новата версия - разра​бот​чиците могат да посочат най-старата версия, която е допустимо да бъде стартирана.

· Инсталиране/деинсталиране – създаване/изтриване на препратки (shortcuts) в подходящите папки.

· Генериране на подходящи уеб страници за уведомяване на потре​бителя.

· Опция за стартиране в offline режим – улеснено е в сравнение с .NET Framework 1.х.
Windows Installer

Следващата стратегия за разпрострения на приложенията е чрез инстала​ционни пакети на Windows Installer (.msi файлове). Тази стратегия пред​лага най-много възможности сред изброените и чрез нея могат да се инсталират всички видове .NET приложения заедно със споделените инсталационни компоненти (merge modules) и CAB файлове. 
Предимства на Windows Installer

Windows Installer предлага множество улеснения за потребителите, адми​нистраторите и разработчиците. Основните от тях са:
· Лесен за използване потребителски интерфейс, който може да се настройва от разработчиците (customizable UI).

· Интеграция с инструмента Add/Remove Programs от Control Panel за следните действия:
· Инсталиране.
· Деинсталиране.
· Добавяне или премахване на функционалност (features) от приложенията.
· Поправяне на инсталираното приложение като се запазват напра​вените промени и се възстановяват повредените файлове.
· Изпълнение в тих режим (silent mode) – без намесата на потреби​теля.

· Възстановяване на системата до състоянието преди започване на инсталацията в случай на:

· Възникване на грешка.
· Прекъсване от потребителя.

· Проверяване за наличието на определен софтуер и хардуер преди започване на инсталацията.
· Създаване на подходящи препратки (shortcuts).
· Управление на местоположението на файловете и папките.
· Управление на регистрите на Windows (Windows registry).
· Инсталиране на COM базирани компоненти.
· Инсталиране на асемблита в Global Assembly Cache.
· Изпълнение на допълнителни действия след инсталацията (custom actions).
· Управление на информацията за версиите, като по този начин се осигурява инсталиране на ъпгрейдите (upgrades) и кръпките (patches) в правилен ред.

Както се вижда от посочения списък с предимствата на използването на Windows Installer, това е много мощна технология и използването й позволява решаване на проблемите, съпътстващи сложните Windows и уеб базирани приложения. Ето и някои от тях:
	Задача
	Решение чрез MSI пакет

	Споделени асемблита – поставяне на асемблита в GAC
	Windows Installer предоставя лесен начин за инсталиране на споделени асемблита в Global Assembly Cache.

	Инсталиране на COM базирани компоненти
	Както обяснихме в точка COM базирани обекти, COM обектите трябва да се регистрират преди да се използват. Windows Installer предоставя надежден механизъм за инсталиране и регистриране на COM обекти. При нужда може да се използва и инстру​мента RegSvr32.exe за ръчно регистриране на COM обектите.

	Настройки на IIS
	В точка Настройки на Internet Information Server (IIS) обяснихме основните настройки, които трябва да бъдат направени, за да се стартират уеб прило​жения. Windows Installer позволява задаването на тези настройки по време на създаване на инстала​ционния пакет.

	Ресурси на приложението
	Приложенията изискват различни ресурси като опашки от съобщения (message queues), логове на събитията (event logs), индикатори за производи​телността (performance counters) и бази данни (databases) (виж Инсталационни компоненти), сате​литни асемблита за локализиране на приложението (виж. Локализиране). Windows Installer поддържа изпълнението на допълнителни действия (custom actions) преди приключване на инсталационния процес, чрез които могат да се изпълнят почти всички необходими действия.


Windows Installer за инсталиране на многослойни приложения
При комплексни системи, изградени от няколко слоя, трябва да се изпол​зва отделен инсталационен пакет за всеки отделен физически слой (всяка отделна машина). Това е подходящо при повечето сценарии, защото е изключително трудно (в някои случаи дори невъзможно) да се стартира един инсталационен процес на даден физически слой и да се инсталират компоненти на други физически слоеве като част от него. Например ако се стартира инсталационен пакет за уеб приложение, е трудно да се инсталират компонентите, които съдържат бизнес логиката, на отделен компютър. В някои случаи за всеки отделен физически слой може да бъде избрана различна инсталационна стратегия. Например слоят, който съдържа уеб-базираният потребителски интерфейс може да бъде разпро​странен като колекция от файлове след компилацията, докато слоят с бизнес логиката и сървърът за базата данни могат да бъдат поставени в MSI пакет.
Съображения за сигурността
Един от проблемите, които засягат разпространението на Windows бази​рани приложения чрез MSI пакети е дали потребителят, който е стартирал инсталационния процес, има необходимите права, за да проведе и при​ключи инсталацията. Тези права зависят от действията, които се извър​шват по време на инсталационния процес и платформата, върху която се осъществяват. Например не се изискват специални права, за да се инсталират приложения върху Windows 95, Windows 98, Windows Me, докато в Windows NT/2000/XP/2003 само създаването на поддиректория на системната папка Program Files изисква потребителят да е в група със специални права (като Administrators или Power Users).
Начин да се осигурим, че инсталацията няма да се провали заради недо​статъчни права на активния потребител, е разпространение на инстала​ционния пакет чрез MS SMS или Active Directory Group Policy.
Разпространение на пакети на Windows Installer

Съществуват различни начини за разпространение на MSI пакети:
· Active Directory Group Policy.
· MS System Management Server (SMS).
· Други начини – поставяне на файлов сървър, на уеб сървър или разпространение на носител (CD/DVD).
Нека разгледаме всеки един от тях.
Групови политики на активните директории (Active Directory Group Policy)
При работа в големи организации работните станции се организират в домейни, управлявани от т. нар. активна директория (Active Directory). Тя е част от сървърните Windows платформи (Windows 2000 Server, Windows 2003 Server и т. н.) и се използва за централизирано управление на Windows базирани корпоративни инфраструктури.

Активната директория позволява разпространението на приложение до потребителите или машините автоматично, чрез използва​нето на групо​вите политики (Group Policy). Груповите политики могат да се задават на ниво домейн, организационна единица, потребител или компютър. Това зависи от структурата на дадената организация. Чрез груповите политики може да се осигури автоматично инсталиране на приложението, когато даден потребител се включи в системата (или даден компютър се стар​тира).
Груповите политики позволяват разпространение на приложения по два начина:

· Назначение (assign) – администраторът може да назначи дадено приложение за потребители или машини.

· За потребители – приложението се инсталира, когато даденият потребител се включи в системата. Когато потребителят стартира някоя програма за първи път, тогава инсталацията се финали​зира.

· За машини – когато машината се стартира, приложе​нието се инсталира и то е свободно за използване от всички потребители на тази машина. Инсталацията се финализира, когато потребите​лят стартира някоя програма.

· Публикуване (publishing) – приложението може да се публикува за определени потребители. Когато те се включат публикуваната про​грама се появява в Add/Remove Programs и може да бъде инстали​рана от там. Като алтернатива може да се посочи приложението да се инсталира при стартиране на файл, чийто тип е асоцииран с него.

Разпространение на MSI пакет чрез групова политика на активната директория – пример
За да настроим инсталационен пакет за инсталиране чрез груповата политика на активната директория (Active Directory Group Policy), можем да изпълним следните стъпки (примерът е с Windows 2003 Server):

1. Създаваме директория, която ще съдържа MSI пакета на файлов сървър. Настройваме директория за съвместно ползване (shared directory) и задаваме необходимите права.

2. Стартираме конзолата "Active Directory Users and Computers".

3. От структурата вляво избираме контейнера, който съдържа компют​рите, за които ще назначаваме инсталация на приложение. Щрак​ваме с десния бутон на мишката върху него и избираме Properties и после Group Policy таба.

4. Създаваме нова групова политика (Group Policy Object), чрез бутона [Add] и задаваме подходящо име. Например “MSI Install Test”:
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5. Уверяваме се, че новата група е избрана и натискаме бутона [Edit]. Ще се отвори конзолата Group Policy Object Editor.
6. От дървото вляво отваряме Computer Configuration, разпъваме пап​ката Software Settings и избираме иконата Software Installation. От нейното контекстно меню избираме New… | Package:
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7. Отваря се диалог, чрез който трябва да изберем .msi файла за този пакет. Намираме споделената папка на файловия сървър, която създадохме в стъпка 1. Избираме файла и потвърждаваме с бутона [Open]. Ако файлът се намира на локалния диск, не трябва да използваме локалния път (примерно c:\PathToMSI), защото клиен​тите няма да имат достъп до пакета. Вместо това трябва да изпол​зваме UNC път – \\име-на-сървъра\име-на-папката\файл.msi.
8. От следващия диалогов прозорец избираме [Assigned] и потвържда​ваме с [OK]:
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Ако изберем вместо това [Advanced], ще се отвори нов прозорец, в който можем да правим допълнителни настройки за разпростране​нието на пакета. Това може да стане и по-късно чрез избиране на Properties от контекстното меню на създадения пакет.

9. Виждаме новосъздадения пакет в конзолата Group Policy Object Editor. В нашия случай той ще бъде инсталиран при следващото влизане на потреби​телите в системата или при стартиране на компютрите, които са част от домейна.
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MS System Management Server (SMS)

System Management Server v2.0 служи за лесно централизирано управ​ление на инсталации на софтуерни пакети в корпоративна мрежа Основ​ните предимства на SMS са:

· Разпространение на приложения на множество клиентски платфор​ми. Всички версии на Windows се поддържат от SMS.

· Контрол над натоварването на мрежата. SMS позволява наблюдение на мрежовия канал и неговото натоварване като позволява настрой​ване и избягва допълнителното натоварване в неподходящо време от денонощието.

· Работа с определени потребители и машини. Приложенията може да се разпространяват на база потребителско име, име на група, име на компютър, име на домейн и мрежов адрес.

· Използване на график за разпространение на софтуер. Разпрост​ранението се извършва по предварително указан график. Това е полезно за избягване на натоварването по определено време на денонощието.

· Състояние на разпространението. SMS показва състоянието на инстала​цията и позволява навременно реагиране в случай на грешки.

· Краен резултат на разпространението. Ако приложението е било успешно инсталирано на даден клиент, това не означава, че целият процес е бил успешен. SMS предоставя детайлна информация за крайния резултат.

SMS има свой механизъм за разпространение на приложенията и не изисква задължителното използване на пакети на Windows Installer, но поддържа MSI пакети.

Други методи

Съществуват и няколко други метода за разпространение на MSI пакети:

	Метод
	Описание
	Предимства/Недостатъци

	Уеб/FTP сървър
	Пакетите са поставени на сървър от локалната мрежа или в Интернет и връзка към тях е изпратена на потребителите.
	Добър начин за предоставяне на приложе​ние на широка аудитория.
Пакетите могат да бъдат архивирани (на​пример в .ZIP архив), за да се избегне директно стартиране.

Няма контрол върху свалянето на пакетите.

Изискват се административни права за ус​пешна инсталация.

	Мрежов сървър
	Пакетите са поставени на сървър и връзка към тях е изпратена на потребителите.
	Добър начин за разпространение в дадена организация.
Пакетите могат да бъдат архивирани (на​пример в .ZIP архив), за да се избегне директно стартиране.

Няма контрол върху свалянето на пакетите.

Изискват се административни права за ус​пешна инсталация.

	E-mail
	Пакетите се изпращат чрез електронната поща
	Лесни са за намиране.
Не могат да се стартират директно, заради блокирането им от клиентите за електрон​на поща. Могат да бъдат филтрирани от системи за защита от спам и вируси.
Може да доведе до значително натовар​ване на сървърите.

Изискват се административни права за ус​пешна инсталация.

	CD/DVD
	Пакетите са записани на оптичен носител.
	Лесно преносими.
Подходящи, където мрежовият канал не е достатъчно широк или пакетите са много обемни.

Изискват се административни права за ус​пешна инсталация.


Инструменти за създаване на MSI пакети
Visual Studio .NET 2003 поддържа създаването на инсталационни проекти, въпреки че не използва пълните възможности на технологията Windows Installer. Затова ще посочим най-често използваните инструменти за работа с MSI пакети.  Основно може да разделим инструментите на две групи:
1. Произведени от Майкрософт:

· Visual Studio .NET 2003 – поддържа създаването на основни инсталационни пакети и предлага сравнително добър интерфейс за изграждане на инсталационния процес. Подходящ е за средни по сложност приложения.
· Orca – съдържа се в Platform SDK. Предлага среда за редактиране на файлове на Windows Installer (.msp, .msi, .msm). Изключи​телно мощен, но сложен – подходящ за експерти в технологията  Windows Installer.
· Windows Installer XML (WiX) – това е проект по инициатива на Майкрософт и по M Shared Source Licensing (виж  http://www.microsoft.com/resources/sharedsource/licensing/WiX.mspx и http://sourceforge.net/projects/wix/). Позволява описанието на MSI пакетите да се използва XML сорс код, който се компилира до .msi файл. Подходящ за напреднали разработчици.
2. От други производители:

· InstallShield – продукт на Macrovision (бившата InstallShield). Изключително интуитивен и лесен за използване интерфейс. Работата е улеснена от наличието на съветници (wizards). Инте​грира се отлично във Visual Studio .NET 2003. Документацията е много подробна и за най-често използваните задачи са дадени примери. Предоставя свой собствен скриптов език (InstallScript), който позволява контролиране на инсталационния процес във всичките му аспекти. Официалният уеб сайт на InstallShield е http://www.installshield.com/products/installshield/.
· Wise for Windows Installer – продукт на Wise, който се интегрира с Visual Studio .NET 2003. Мощен продукт и лесен за употреба. Също предоставя свой скриптов език за контролиране на инстала​ционния процес. Официалният уеб сайт на Wise for Windows Installer е http://www.wise.com/wfwi.asp.
Колекция от файлове след компилация
За много уеб приложения и някои опростени Windows приложения е по-подходящо разпространението чрез просто копиране на файлове на сървъра, вместо изграждането на сложни MSI пакети. Под колекция от файлове имаме предвид всички файлове, които се използват от прило​жението – .apsx, .dll, .exe, .config, графични файлове и други ресурси.
Предимствата на тази инсталационна стратегия са:

· Леснота за инсталиране – файловете се инсталират на машината чрез просто копиране.

· Леснота за ъпгрейд – новите файлове се копират върху старите.

За разлика от Windows базираните приложения, уеб приложенията се инсталират от администратор или опитен IT специалист. В много случаи такива приложения не се инсталират, деинсталират и поправят чрез Add/Remove Programs от Control Panel. Възстановяване предишното състояние на машината при грешка също не е необходимо условие – по-лесно е за администратора да промени настройките на IIS или да отстрани дребни проблеми вместо да рестартира целия инсталационен процес.
Въпреки, че тази стратегия работи добре с по-прости приложения, тя не е подходяща при следните ситуации:

· промяна в Windows Registry

· добавяне, изтриване или промяна на Windows услуги

· промяна по политиките на сигурността (security policy)

· добавяне, изтриване или промяна на COM базирани обекти
· работа с Global Assembly Cache
При работа с по-сложни приложения е препоръчително използването на Windows Installer.
Начини на разпространение

Самото разпространение на файловете може да се извърши по следните начини:

· Чрез Microsoft Application Center – изключително подходящо при т. нар. уеб ферми (Web farms). Те представляват клъстер от няколко машини, които предоставят уеб услуга или уеб приложение. При инсталиране на уеб приложение върху уеб ферма е необходимо всяка една от машините да има едни и същи файлове, инсталирани компоненти, настройки на IIS и др. Използването на Microsoft Application Center осигурява съдържанието на машините в уеб фер​мата да бъде еднакво. Microsoft Application Center не е подходящ за разпространение на MSI пакети, Windows базирани приложения, Windows услуги и бази данни.

· Чрез Copy Project командата от Visual Studio .NET 2003 (само за уеб приложения). Създава виртуална директория на посочения сървър и копира файловете в нея:
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Има следните опции за копиране:

· Само файловете, необходими за изпълнение на приложението – включва: файловете създадени по време на компилация, реферираните асемблита, както и всички файлове, които са добавени в проекта на Visual Studio .NET и за които е зададено BuildAction=true.
· Всички файлове от предходната точка и всички проектни файлове.
· Всички файлове от проектната директория и всички подди​ректории.

· Директно копиране на файлове – подходящо е само, ако не трябва да се променят регистрите на Windows (Windows registry) или да се изпълняват допълнителни задачи (като настройки и рестартиране на IIS, промяна на настройките за сигурността и т.н.).

Създаване на MSI инсталационен пакет
След като описахме различните инсталационни стратегии е време да преминем към практическата част. За съжаление няма да можем да обхванем всички описани варианти за разпространение, но ще демонстри​раме най-важните от тях. Ще се спрем на два вида MSI пакети – за Windows базирано приложение и за уеб базирано приложение.

Примерът, който ще разгледаме, включва следните проекти:

· CreditCardValidatorWS – уеб услуга, която проверява валидността на кредитна карта.

· CreditCardValidatorClient – Windows базирано приложение, което използва методите на CreditCardValidatorWS.
· MyLibrary – библиотека от класове, съдържаща клас за четене на ресурсни файлове, които са компилирани в асемблитата. Силно име​нуваното асембли MyLibrary.dll ще бъде добавено в GAC.
Ето как изглежда във VS.NET решението, което включва трите проекта:
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Няма да навлизаме в описание на тези проекти, понеже целта е друга – да покажем процеса на създаване на инсталационни пакети за всеки от тях.
Създаване на инсталационен пакет на Windows базирано приложение
Нека първо създадем инсталационен пакет за Windows Forms базираното приложе​ние CreditCardValidatorClient.

От зареденото решение CreditCardValidator.sln във Visual Studio .NET 2003, избираме File -> New -> Project и избираме Setup Project от категорията Setup and Deployment Projects. За име въвеждаме InstallClient и избираме опцията Add to Solution. Потвърждаваме с бутона [OK].
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Новият проект се създава и се добавя към решението CreditCardValidator.sln.
Характеристики на инсталационния проект

Трябва да зададем свойствата на проекта – да зададем име на продукта, код, производител и др. За целта избираме проекта InstallClient и отваряме прозореца Properties на Visual Studio .NET 2003. Задаваме стойности на свойствата Title и ProductName “Credit Card Validator”. Задаваме и автор и производител на продукта, ако е необходимо:
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Добавяне на файлове към инсталационния проект
Следващата стъпка е добавяне на проектните файлове към създадения инсталационен проект. От контекстното меню на проекта InstallClient избираме Add -> Project Output…
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Отваря се диалогов прозорец, от който се избира кои части на проекта (и конкретния проект) да се включат в инсталацията. Избираме проекта CreditCardValidatorClient, избираме Primary Output. (Тази опция доба​вя само файловете, които се създават по време на компилация. Всички други файлове трябва да се добавят допълнително.)
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Потвърждаваме с бутона [OK] и към инсталационния проект е добавен Primary Output. Обърнете внимание, че Visual Studio .NET 2003 е доба​вило реферираното асембли MyLibrary.dll в категорията Detected Dependencies. По подразбиране папката, в която ще бъде инсталирано MyLibrary.dll, е инсталационната папка на прило​жението, която потребителят избира по време на инсталация. За да инста​лираме MyLibrary.dll в Global Assembly Cache трябва да направим допъл​нителни настройки.
В изгледа File System на инсталационния проект (отваря се от контекст​ното меню на инсталационния проект InstallClient -> View -> File System) отваряме контекстното меню на File System on Target Machine -> Add Special Folder -> Global Assembly Cache Folder:
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След като вече имаме добавен GAC към инсталационните папки на проекта може да зададем местоположението на MyLibrary.dll. Отваряме контекстното меню на  MyLibrary.dll от Solution Explorer (от категорията Detected Dependencies на проекта InstallClient) и избираме Properties. От прозореца Properties избираме свойството Folder. Неговата стойност по подразбиране е Application Folder. Избираме бутона [image: image33.png]


 и от диалоговия прозорец Select Folder избираме Global Assembly Cache и потвърждаваме с бутона [OK].
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Създаване на икони за инсталираното приложение
За да е завършен инсталационния процес трябва да добавим препратки за бързо стартиране на приложението. За програмни продукти, насочени към обикновените потребители (не администратори) е задължително добавя​нето на препратки в Start Menu на Windows. Добавянето на препратки на работната площ (desktop) и лентата за бързо стартиране (Quick Launch) не е задължително, но може да се извърши за удобство на потребителя.

Добавяне на препратки в  Start Menu на Windows
От изгледа File System избираме User's Programs Menu с десен бутон на мишката и от контекстното меню избираме Add -> Folder. За име на пап​ката въвеждаме "Credit Card Validator". Избираме я и от контекстното меню на детайлната област (в средата) избираме Create New Shortcut. 
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От отворилия се диалогов прозорец избираме Application Folder -> Primary Output for CreditCardValidatorClient (Release .NET). Затваряме прозореца с бутона [OK].
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В детайлната област се добавя препратка към основния файл на приложението. Името е в режим на редактиране и можем да въведем подходящо име, напр. "Credit Card Validation":
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По подразбиране лип​сва икона за тази препратка. От прозореца Properties избираме свойството Icon и се отваря прозорец за избор на икона. Файлът трябва да е включен в инсталацията. Добра практика е да се избира иконата от изпълнимия файл, към който сочи препратката. Ако изберем .exe от проекта CreditCardValidatorClient, се показват се всички икони, които се съдържат в него:
[image: image38.png]File name:
Primary output fram CreditCardvalidatorClent (Release  Browse.

Current ican:

el | b





Избираме подходяща икона и потвърждаваме с бутона [OK].
Добавяне на препратка на работния плот (Desktop)

Добавянето на препратка на работния плот технически не се различава много от Добавяне на препратки в  Start Menu на Windows.
В указанията на Майкрософт за Windows базираните приложения (“Designed for Microsoft Windows XP” Application Specification – http://www.microsoft.com/ winlogo/software/downloads.mspx) е посочено, че поради претрупване на работния плот следва поставянето на икони да се извършва само по изрично указание на потребителя. Технически това означава добавяне на диалогов прозорец, в който потребителя да укаже предпочитанията си. Като следваме указанията от точката Добавяне на препратки в  Start Menu на Windows, добавяме икона в папката User's Desktop.
Показваме изгледа User Interface – от контекстното меню на инстала​ционния проект InstallClient, избираме View -> User Interface. В него е показана последователността на диалозите, които се показват по време на нормална инсталация и административна инсталация. 
От контекстното меню на диалога Start избираме Add Dialog:
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Показва се диалоговия прозорец Add Dialog, от който можем да изберем шаблон, съдържащ контролите, от които имаме нужда:
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Избираме шаблона CheckBoxes (A) и потвърждаваме с бутона [OK]. Новосъздаденият диалог се добавя като последен в поредицата, но е необходимо да бъде преместен преди диалога Installation Folder. С левия бутон на мишката може да го влачим и пуснем върху диалога Welcome или от контекстното меню на CheckBoxes (A) да избираме позицията му чрез командите Move Up и Move Down. След това действие последователността на диалоговите прозорци трябва да е подобна на тази:
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След като вече имаме подходящия диалог в поредицата, трябва да го настроим, за да показва подходящи съобщения. От прозореца с неговите свойства въвеждаме както следва:
	Свойство
	Стойност

	Banner Text
	Credit Card Validation

	Body Text
	Select which shortuts to be placed during installtion

	CheckBox1Label
	Create shortcut on Desktop

	CheckBox1Property
	CHECKBOXDESKTOP

	CheckBox2Label
	Create shortcut in Quick Launch

	CheckBox2Property
	CHECKBOXQUICKLAUNCH

	CheckBox2Value
	Checked

	CheckBox3Visible
	false

	CheckBox4Visible
	false


Ето как изглежда този диалогов прозорец в действие:
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Вече имаме функциониращ диалогов прозорец в поредицата на нашия MSI пакет. Имаме и зададени променливи, които пазят избора на потребителя ([CHECKBOXDESCTOP] и [CHECKBOXQUICKLAUNCH]). Сега трябва да ги доба​вим като условие за инсталиране. 
От изгледа File System избираме User's Desktop отваряме прозореца с характеристиките (командата Properties от контекстното меню). За свой​ството Condition задаваме стойност "[CHECKBOXDESKTOP]=1".
Добавяне на препратки в Quick Launch

Quick Launch е възможност на Internet Explorer да показва лента с препратки на работния плот на Windows. Пътят до тази директория по подразбиране е C:\Documents and Settings\[UserName]\Application Data\Microsoft\Internet Explorer\Quick Launch като на мястото на [UserName] стои името на текущия потребител. За щастие в променливите на Windows Installer съществува User's Application Data Folder, която извлича пътя до C:\Documents and Settings\[UserName]\Application Data на текущия потребител. Можем да добавим директорията User's Application Data Folder от контекстното меню File System on Target Machine -> Add Special Folder -> User's Application Data Folder.
След това от изгледа File System избираме User's Application Data Folder с десен бутон на мишката и от контекстното меню избираме Add -> Folder. За име въвеждаме Microsoft. От контекстното меню на новосъз​дадената папка повтаряме горното действие и създаваме поддиректория Internet Explorer. В нея създаваме поддиректория Quick Launch.
От контекстното меню на детайлната област избираме Create New Shortcut и повтаряме действията от точка "Добавяне на препратки в  Start Menu на Windows".
Като резултат екранът трябва да изглежда подобно на този:
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За да може потребителят да избира дали да се създаде препратка в Quick Launch (чрез диалоговия прозорец, който създадохме в точка "Добавяне на препратка на работната площ (Desktop)") трябва да зададем инстала​ционно условие: избираме папката User's Application Data Folder и от прозореца с характеристиките въвеждаме за свойството Condition стойност "[CHECKBOXQUICKLAUNCH]=1".
Препратка за деинсталиране на приложението

Като цяло създаването на препратка за деинсталиране на приложението не се препоръчва от Майкрософт и е залегнало в указания за приложения за Windows (“Designed for Microsoft Windows XP” Application Specification – http://www.microsoft.com/winlogo/software/​downloads.mspx). Поради спе​цификата на добавяне на подобна функционалност и честите практики на софтуерните компании да поставят подобна препратка в стартовото меню ще го опишем. Това следва да се разглежда като пример за създаване на икони към приложения, които не се инсталират от текущия MSI пакет.
За да се запази целостта на MSI пакета, Windows Installer не позволява поставяне на препратки към файлове, които не се разпространяват с дадения MSI пакет. По този начин се предотвратява зависимостта на MSI пакетите към външни файлове. Както ще покажем в точката "Инстали​ране/деинсталиране на MSI пакетите", основният команден файл на Windows Installer е msiexec.exe. Това е командата, към която Windows на насочва обработката на MSI пакетите независимо от мястото, от което са инициирани (Control Panel, Windows Explorer или чрез команда). 
Създаваме файл Uninstall.bat в директорията на проекта CreditCardValidatorClient със следното съдържание:

	Uninstall.bat

	msiexec /x {A3E3AA3C-3D63-4A5B-8F0A-B32BDEDCD4D8}


Последния параметър е от свойството ProductCode на инсталационния проект (вж. Характеристики на инсталационния проект).
От контекстното меню на проекта InstallClient избираме Add -> File… и избираме Uninstall.bat. След като вече имаме подходящ файл може да създадем препратка в стартовото меню към Uninstall.bat.

Създаване на инсталационен пакет на уеб услуга

След като създадохме инсталационен пакет за Windows приложението, остава да добавим и инсталационен пакет за уеб услугата.

От зареденото решение CreditCardValidator.sln във Visual Studio .NET 2003, избираме Add -> New Project и избираме Web Setup Project от категорията Setup and Deployment Projects. За име въвеждаме InstallWebService и избираме опцията Add to Solution. Потвърждаваме с бутона [OK].

Новият проект се създава и се добавя към решението CreditCardValidator.sln.
Задаваме стойности на свойствата Title и ProductName “Credit Card Web Service” от прозореца с характеристиките на инсталационния проект проекта както направихме в точка Характеристики на инсталационния проект.
Както и в подточка Добавяне на файлове към инсталационния проект към Създаване на инсталационен пакет на Windows базирано приложение ще добавим проектните файлове към създадения инсталационен проект. От контекстното меню на проекта InstallClient избираме Add -> Project Output…

Както вече споменахме, Project Output включва създаваните по време на компилация файлове – .exe, .dll и .config. За да е функционална уеб услугата, трябва да добавим още фалове – Web.config, Global.asax и CreditCardValidator.asmx. За целта отваряме изгледа File System на инсталационния проект InstallWebService (от контекстното меню на InstallWebService избираме View -> File System). От контекстното меню на Web Application Folder избираме Add -> File… Отваря се стандартен File Open Dialog. Отваряме проектната директория на проекта CreditCardValidatorWS и избираме файловете Web.config, Global.asax и CreditCardValidator.asmx:
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От прозореца със свойствата на Web Application Folder задаваме на VirtualDirectory стойност "CreditCardValidatorWS". Това е всичко.
Допълнителни настройки на инсталационните проекти във Visual Studio .NET 2003

За всеки от двата инсталационни проекта се създават по три файла след компилация на решението: Setup.Exe, Setup.Ini и [име на проекта] .msi (InstallWebService.msi и InstallClient.msi).
Освен това по подразбиране файловете се пакетират с ниско ниво на компресия. За да променим това, от характеристиките на инсталационния проект (от менюто на Visual Studio .NET 2003 Project -> Properties) задаваме следните характеристики: 
· Bootstraper – None

· Compression – Optimize for size
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В резултат след компилация ще се генерират по един .msi файл за всеки от проектите, който ще бъде оптимално компресиран.
Инсталиране/деинсталиране на MSI пакетите
След като създадохме двата инсталационни пакета, е време да ги тества​ме. Компилираме ги и намираме .msi файловете. Препоръчително е да използваме Virtual PC за тестовете, за да няма конфликти с вече инста​лираните приложения и за да проверим дали всичко работи върху чиста инсталация на Windows и IIS. Ако тестваме локално, ще се получи конфликт с CreditCardValidatorWS, тъй като InstallWebService.msi съз​дава виртуална директория в IIS с име CreditCardValidatorWS.
Инсталацията на MSI пакет може да се стартира чрез двойно щракване на мишката върху .msi файла или чрез командата:

	msiexec.exe /I InstallClient.msi


Първо инсталираме InstallClient.msi. Инсталацията протича по начин, който е добре познат на потребителите. Обърнете внимание, че препрат​ките от InstallClient.msi са създадени в зависимост от избраните настройки в диалоговия прозорец, който доба​вихме в точка Добавяне на препратка на работната площ (Desktop).
Стартираме и инсталацията на уеб услугата от InstallWebService.msi. От втория диалогов прозорец имаме възможност да зададем настройките на виртуалната директория, която ще бъде създадена в IIS.
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Не правим промени по тези настройки и завършваме инсталационния процес.
Ако сте направили промени в настройките на виртуалната директория в IIS от прозореца по-горе (или уеб услугата е инсталирана на отделен компютър) трябва да се промени конфигурационният файл на клиентското приложе​ние, за да може да се достъпи уеб услугата.
Ето го съдържанието на конфигурационния файл на CreditCardValidatorClient:
	CreditCardValidatorClient.exe.config

	<?xml version="1.0" encoding="utf-8" ?>

<configuration>


<appSettings>



<add key="webServiceURL" value="http://localhost/creditcardvalidatorws/CreditCardValidator.asmx"/>


</appSettings>

</configuration>


На по-късен етап приложенията могат да се деинсталират чрез Control Panel -> Add/Remove Programs или чрез командата:
	msiexec.exe /x InstallClient.msi


Упражнения
1. Създайте многомодулно асембли. Именувайте го силно. Разгледайте манифеста му.
2. Създайте проект TestLibrary от тип Class Library. Дайте силно име на резултатното асембли TestLibrary.dll. Добавете в проекта примерен клас и статичен метод, който връща в резултат текста “MyAssembly v.1.0.0.1”. Използвайте атрибутите в AssemblyInfo.cs, за да зададете за асем​блито версия 1.0.0.1.
3. Създайте Windows базирано приложение TestWinApp и реферирайте от него асем​блито от предходното упражнение (TestLibrary.dll) като частно асембли. Можете да направите това като от VS.NET добавите референ​ция към проекта TestLibrary. При стартиране на проекта TestWinApp покажете диа​логова кутия със съдър​жание върнатия от статичния от метод TestLibrary текст. След компилация би трябвало в изходната директория да имате файловете TestWinApp.exe и TestLibrary.dll.
4. Създайте поддиректория assemblies в директорията с компилираното приложение от предходното упражнение (TestWinApp.exe) и преме​стете в нея асемблито TestLibrary.dll. Добавете конфигурационен файл и задайте частни пътища за търсене на частните асемблита с тага <probing>. Посочете директорията assemblies. Приложението работи правилно, нали? Пре​махнете тага <probing> от конфигурацион​ния файл и използвайте вместо него тага <codebase>. Тествайте отново.
5. Добавете асемблито от TestLibrary.dll в GAC. Изтрийте поддирек​тория assemblies. Приложението TestWinApp.exe работи нормално, нали? Деинсталирайте TestLibrary.dll от GAC. Приложението спря да работи, нали?
6. Променете текста, връщан от статичния метод от проекта TestLibrary, на “MyAssembly v1.0.0.2” и променете версията на 1.0.0.2. Добавете новата версия на асемблито TestLibrary.dll в GAC. Приложението TestWinApp.exe все още не работи, нали?
7. Създайте Publisher Policy File, за да пренасочите TestLibrary.dll 1.0.0.1 към TestLibrary.dll 1.0.0.2. Приложението TestWinApp.exe трябва отново да работи нормално.
8. Създайте проста система за събиране на числа, реализирана като уеб услуга с Windows базиран и уеб базиран клиент. Създайте инстала​ционни пакети за уеб услугата и за клиентските приложения. Инстали​райте ги върху друга машина и ги тествайте. Работят ли правилно? Деинста​лирайте ги чрез Control Panel -> Add/Remove Programs. Работи ли правилно деинсталацията?
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